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Um das Projekt der vorherigen Anleitung nicht zu veréindern, werden die Entwurfsergebnisse
in Form der mhs- und der ucf-Datei in ein neues Projekt iibernommen. Dazu ist in EDK ein
neues Projekt zu erzeugen. In dem sich 6ffnenden Fenster ist der FPGA-Typ und das mhs-File
des vorherigen Projekts wie in Abb. 1 auszuwihlen!. Nach Erzeugen des neuen Projekt ist die
Datei »system.ucf« im Unterverzeichnis » /data« durch die des vorherigen Projekts zu ersetzen.

Schritt-fiir-Schritt-Anleitung tiir den Test des
LMB-I0-Systems mit ChipScope

Prof. G. Kemnitz, TU Clausthal, Institut fiir Informatik

22. April 2016

Zusammenfassung

Das in der vorherigen Anleitung erzeugte System wird in dieser Anleitung um integrier-
ten Logikanalysator fiir unterschiedliche Testaufgaben erweitert. Zuerst sollen in analoger
Weise wie in Anleitung 3 die Trace- und Led-Signale fiir einen inneren Schleifendurchlauf
beim Hochzéhlen eines Led-Ausgabewerts untersucht werden. Ziel ist die Abschidtzung, wie
lange der Schreibzugriff {iber den LMB auf ein Ausgaberegister dauert. Im zweiten Versuch
werden die Ausgabesignale des Festwert-Timers FIT1, und wie lange die Programmreak-
tion auf ein Timer-Event dauert, untersucht. Im dritten Versuch werden die Signale auf
dem LMB untersucht. Da es fiir den LMB keinen Busanalysator wie fiir den AXI-Bus gibt,
wird ein anderes Werkzeug, der » ChipScope Core Inserter« genutzt. Mit dem »Core In-
serter« lassen sich auch alternative Signale als Aufzeichnungstakt verwenden. Als Beispiel
hierfiir wird im letzten Versuch ein integrierter Logikanalysator fiir die Aufzeichnung des
UART-Sende- und Empfangssignal mit dem 500 kHz Signal am Toggle-Ausgang von FIT1
getaktet.

Kopieren des LM B-I0O-Systems in ein neues Projekt

4% Create New XPS Project x|

—New project
Project file IH:'\SUFtpruzessur\LMB_LAksystem.xmp Browse ... |

—Target device
Architecture Device Size Package Speed Grade

|spar‘tan6 j |xc65lx16 j Icsg324 j |-2 j

—Advanced options
¥ Import Design File (.mhs) from existing Project

IH:'\SUftprUzessothMB_IOksystem.mhs Browse ...

Abbildung 1: Erzeugung eines neuen Projekts der bisherigen Schaltung

L Alle Auswahlfelder darunter sind abzuwahlen.
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Abb. 2 zeigt das Blockschaltbild des importierten Rechnersystems ohne integrierte Logik-
analysatoren. Es enthélt den Prozessor mit je einem LMB (local memory busses) fiir Befehle
und Daten. Beide LMB’s sind iiber einen Speicher-Controller mit je einem Port des Dual-
Port-Block-RAM'’s verbunden. Zusétzlich ist am Daten-LMB das IO-Modul mit den parallelen
Schnittstellen, Timern und der UART angeschlossen. Nur der Debug-Controller nutzt weiterhin
den AXI-Bus.

Takteingang Prozessor Businstanzen Schnittstellen-Controler Speicher
Microblaze (Prozessor) Imb_v10 Imb_bram_if_cntlr bram_block
ILMB H —|SYS RST L_{SLMB BRAM_PORT [~ pORTA
> LMBCLK
Clk CLK Imb_bram_if_cntlr
Imb_v10
DLMB e ¢— SLMB BRAM_PORT [~ PORTB
>
—{ MB_RESET
GPO2
P — LMB-1/0-Modul ;507
M_AXI_DP — SLMB
N GPI1
I.._ARESETN — OLK "\_-
GPI2 sw
DEBUG 1._ACLK I Rst s |
ol UART_Tx
i UART _Rx
proc_sys_reset (Riicksetzschaltung) mdm (Debug-Controller) 11}{2;
—> Slowes_sync_clk Bus_Struct_Reset S_AXI Debug_SYS_Rst
1—>{ Dcem_locked I.._aresetn [ MDDEBUG_0
e MB_Debug_Sys_Rst - > S_AXI_ACLK

Abbildung 2: Rechnersystem ohne integrierte Logikanalysatoren

In Vorbereitung des Tests mit einem integrierten Logikanalysator empfiehlt es sich, den zu
beobachtenden internen Signalen und den Bausteinen, deren Anschlussignale zu beobachten
sind, eigene aussagekriftige Namen zu geben. Das geht am einfachsten mit » Replace All« im

PORT Clk = Clk_x, DIR = I,
PORT sw = sw_x, DIR = I,.. END
PORT btn = btn_x, DIR = I,

o BEGIN 1lmb_bram_if_cntlr
led_x, DIR = 0,..

PORT Led = - PARAMETER INSTANCE = dbram_cntlr
PORT seg = seg_x, DIR = 0,.
PORT an = an_x, DIR = 0,.. END
PORT RsRx = Rx, DIR = 1I )
PORT RsTx = TX, DIR = O BEGIN lmb_bram_lf_cntl.?
PORT T500kHz = T500kHZ_X, DIR = O PARAMETER INSTANCE = 1bram_cntlr
BEGIN microblaze END
Pé?éMETER INSTANCE = cpu BEGIN bram_block
END PARAMETER INSTANCE = bram
BEGIN 1mb_v10 END
PARAMETER INSTANCE = ilmb BEGIN iomodule
END PARAMETER INSTANCE = io
BEGIN 1mb_v10 PORT FIT1_Toggle = T500kHz_x
PARAMETER INSTANCE = dlmb END

Abbildung 3: Umbenennungen und Ergdnzungen im mhs-File
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mhs-File. Die internen Anschlusssignale sollen den Port-Namen mit angehdngtem » x«, der
Prozessor den Namen »cpux, die lokalen Speicherbusse die Namen »ilmb« und »dlmb« (i —
instruction; d — data), die Speicher-Controller die Namen sibram_cntrl« und »dbram_cntrl«
und der Block-Ram den Namen »bram« bekommen (Abb. 3). Fiir den letzten Versuch mit dem
500 kHz-Toggle-Ausgang von Timer »FIT1« als Aufzeichnungstakt des Logikanalysators ist es
erforderlich, den Toggle-Ausgang des Timers als Schaltungsausgang herauszufiihren?.

2 Logikanalysator fiir die Trace- und Led-Signale

Fiir den ersten Versuch soll der Logikanalysator wie in Anleitung 3 die Trace-Signale fiir den
Befehlszihler, das Befehlswort und »Befehlswort giiltig« sowie die Led-Ausgabe beobachten.
Fiir den zweiten Versuch sollen zusétzlich die Signalverlaufe des Toggle- und des Interrupt-
Ausgabesignals des Festwert-Timer FIT1 mitgeschrieben werden. Das sind alles Signale, die
iiber das Menii » Debug Configuration« und dort den mittleren Punkt » To monitor abitrary level
signal (adding ILA)« beobachtbar gemacht werden kénnen. Zugang zum Konfigurationsmenti:

Debug > Debug Configuration
Schaltfldche »Add ChipScope Peripherial. .«
Auswahlpunkt »To monitor arbitrary system level signals ..«

Im Auswahlfenster »Basic« Abb. 4 sind der Trigger-Gruppe » TRIGO« vom IO-Modul die
Led-Ausgabe ».. GPO1« sowie die Timer-Signale »..FIT1 _Interrupt..« und »..FIT1 Toggle..«
zuzuordnen.

Basic | Advanced |

Available Ports on Instance: Signals Monitored by: |TRIGD j
|iomodul [ ] T200kHz_x

FIT2_Toggle :I Add == iomodul_FIT1_Interrupt_to_chipscope_ila_0
FIT3_Interrupt = o [ledx

FIT3_Toggle << Remove

GPO1 (Connected to led_x) |

Select the number of signal samples you want: |1024 vl
Select the clock to be used on monitoring: Ir.“.lk_x vl

Abbildung 4: Verbindung der zu beobachtenden Ausginge der IO-Schnittstelle mit » TRIG0«

Die Trace-Signale des Prozessors fiir die Befehlsadresse, die Befehlsdaten und die Befehls-
giiltigkeit sollen der Trigger-Gruppe » TRIG1« zugeordnet werden (Abb. 5). Aufzeichnungstakt
sei der interne Eingabetakt »Clk x.

Basic | Advanced |

Available Ports on Instance: Signals Monitored by: ITRIGl vI

ICF'“ [] R | cpu_Trace_Instruction_to_chipscope_ila_0
Trace_Reg_Addr (Connected to Trace_Reg_Addr) | cpu_Trace_PC_to_chipscope_ia 0

| Trace_Reg_Write (Connected to Trace_Reg_Write) ez Rem.:,-.fel cpu_Trace_Valid_Instr_to_chipscope_iia_0
‘Trace_Valid_Instr (Connected to cpu_Trace_Valid_Insi{Es

Abbildung 5: Verbindung der Trace-Signale mit » TRIG1«

2Der Netzlistengenerator des I0-Moduls erzeugt sonst keinen Toggle-Ausgang fiir FIT1.
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Nach Schliefsen der » Debug Configuration« sind nachtréglich die Boudary-Scan-Verbindungen
zwischen dem Debug-Modul »mdm« und dem Controller des integrierten Logikanalysators
»ICON« im mhs-File zu ergénzen:

BEGIN mdm ce

... BEGIN chipscope_icon
PARAMETER C_USE_BSCAN = 1 e

. PORT tdi_in = v_tdi
PORT bscan_tdi = v_tdi PORT reset_in = v_reset

PORT bscan_reset = v_reset PORT shift_in = v_shift
PORT bscan_shift = v_shift PORT update_in = v_update
PORT bscan_update = v_update PORT capture_in = v_capture
PORT bscan_capture = v_capture PORT sel_in = v_sell

PORT bscan_sell = v_sell PORT drck_in = v_drckl

PORT bscan_drckl = v_drckl PORT tdo_out = v_tdo

PORT bscan_tdol = v_tdo END

END

Der Parameter »C_USE_BSCAN = 1« konfiguriert dabei den »mdm« so, dass er den Boundary-
Scan-Port fiir den »ICON« bereitstellt. Anschlieftend empfiehlt sich die Kontrolle mit » Run
DRCs«. Diese sollte weder Fehlermeldungen noch Warnungen liefern. Die Generierung des Bit-
Files und der Daten fiir den Software-Entwurf erfolgt wieder mit

Export Design > Export & Lauch SDK

wobel bei »Include bitstream and BMM file« der Haken zu setzen ist. Der Arbeitsraum in SDK
fiir den Software-Entwurf sei »SW_LMB_LA«.

3 Testvorbereitung in SDK

Nach » Export & Launch SDK« ist in SDK als erstes das » Board Support Package« zu erzeugen:
File > New > Board Support Package

Einstellungen » Use Default Location«, »standalone« und ohne Einbindung von weiteren Bibli-
otheken. Nach dem »Board Support Package« ist wieder eine Anwendung einzurichten:

File > New > Application Project

Der Name sei »ILA_LedTest« und das Template wieder » Empty Application«. Danach ist mit
Rechtsklick auf »ILA-LedTest« iiber

New > Source File

eine Quelldatei mit dem Namen »ila_ledtest.c« anzulegen und in diese das nachfolgende Pro-
gramm zu schreiben, das die Leuchtdiodenausgabe hochzahlt:

#include <xparameters.h>
#include <xio.h>
#define ioadr_led XPAR_IOMODUL_BASEADDR + 0x10
void main(){
u8 dat=0;
while (1){
XIo_Out8(ioadr_led, dat);
dat++;
}
+
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Nach Programmeingabe und erfolgreichem Ubersetzen ist der FPGA zu programmieren
Xilinx Tools > Program FPGA

mit
Run > Run Configuration

Rechtsklick auf »Xilinx C/C++ application« und »New« eine » Run Configuration« einzuricht-
en und das Programm mit »Run« zu starten. Zur Auswertung der aufzuzeichnenden Be-
fehlsworte und -adressen wird das disassemblierte Maschinenprogramm bendétigt. Die Schritte,
um dieses aus dem Elf-File des Programms zu gewinnen, sind:

e in SDK eine Xilinx-Shell 6ffnen:
Xilinx Tools > Launch Shell

e mit »cd« in das Verzeichnis »ILA LedTest\ Debug« wechseln,

e Disassemblierung und Abspeicherung in eine Textdatei mit
mb-objdump -d ILA_LedTest.elf > ILA_LedTest.txt

e Offnen der Textdatei »ILA _LedTest.txt« mit einem Editor und Extraktion der interessie-
renden Programmbereiche.

Das Hauptprogramm mit der zu untersuchenden Schleife beginnt ab der Marke »main« (Be-
fehlsadresse 0x610) und endet mit dem Riicksprung am Ende der Endlosschleife (Befehlsadresse
0x638). In groben Ziigen ist das dasselbe Programm wie in Anleitung 3 . Zu untersuchen ist, wie
viele Takte die Ausfiihrung des Speicherbefehls auf Adresse 0x628, der den Wert der Variablen
»dat« an die Led’s ausgibt. Bei der Ausgabe iiber den AXI-Bus waren es nahezu 10 Takte.

00000610 <main>:

610: 3021fff4 addik r1l, rl, -12 (Stack- und Frame-
614: £fa610008 swi rl19, rl, 8 pointer einrichten)
618: 12610000 addk ri19, ri1, r0
61c: £0130004 sbi r0, rl19, 4
620: b0000004 imm 4
624: 30600010 addik r3, r0, 16 (r3 := 0x40010)
628: 0930004 1bui r4, rl19, 4 (r4 := mem(FP+4))
62c: f0830000 sbi rd, r3, 0 (mem(r3) := r4d)
630: e0730004 1bui r3, rl19, 4 (r3 := mem(FP+4))
634: 30630001 addik r3, r3, 1 (r3 :=r3 + 1)
638: £0730004 sbi r3, r19, 4 (mem(FP+4) := r3)
63c: Db800ffe4 bri  -28 (Sprung nach 0x620)

(FP — Frame-Pointer; FP+4 — Adresse von Dat; 0x40010 — Adresse des Led-Ausgaberegisters.

Abbildung 6: Disassembliertes Hauptprogramm



G. Kemnitz: Praktikum Softprozessor. LMB-IO + ChipScope (SP-SFS-5). 6

4 Untersuchung der Trace- und der Led-Ausgabe

Nach dem das Programm auf dem Softprozessor gestartet ist, soll auch das Programm zur
Ansteuerung des integrierten Logikanalysators auf dem PC gestartet werden:

Windows-Startmenii > All Programms > Xilinx Design Tools
> ISE Design ...> ChipScope Pro > ChipScope 64-bit > Analyzer

(Achtung 64-Bitversion verwenden!). Die Verbindung mit dem FPGA wird wieder mit einem
Klick auf die Schaltfliche &= oben links hergestellt. Der FPGA ist auszuwihlen und aus dem
Wrapper-Verzeichnis des integrierten Logikanalysator ist die cds-Datei, in der die Signalnamen
stehen, zu importieren (Abb. 7).

rimport File

File: chipscope_ila_0.cdc
Directory: HASoftprozessonlLMB_LAWmplementation\chipscope_ila_0_wrappern

Select Mew File

[DEV:OUNIT: 0 (LA) ||

rUnitiDevice

Auto-create Buses

Abbildung 7: Import-Einstellungen fiir die cdc-Datei

Fiir den ersten Versuch soll der Logikanalysator triggern, sobald auf die Led’s der Wert
sieben (bindr 0b111) ausgegeben wird (Abb. 8).

@ Trigger Setup - DEV:0 MyDevice0 (XCGSLX16) UNIT:0 MyILAOD (ILA) nz = E
; Match Unit Function Value Radix Counter
=l ¢ CImoTRIGO == | X{_0000_0111| Bin
o

[y FIT1_Toggle X

[y FIT1_interrupt X

[y cPo7] 0

[y cpaie 0
;‘ Add ||Acti..| Trigger Condition Name [ Trigger Condition Equation Qutput Enable
a )] TriggerConditiond Mo Disabled
&l . |Window Windows: 1| Depth: |1024 Paosition: 10
g| - [wmoow |~ 1] pept: [1024 1
ﬁ Storage Qualification: All Data

Abbildung 8: Trigger zehn Takte vor der Led-Ausgabe Ob111

Nach Start mit », ausreichendem Zoom und der Einstellung von »Reverse Bus Order« fiir
die Befehlsdaten und -adressen wird fiir den Schleifendurchlauf von der Ausgabe Ob111 bis
zur Ausgabe von 0b1000 an die Led’s der Signalverlauf in Abb. 9 aufgezeichnet®. Der Led-
Ausgabebefehl mit der Befehlsadresse 0x62C »sbi 14,13, 0« (mem(r3) := r4) hat im Trace nur
zwei Wartetakte davor und keinen Wartetakt danach. Die Ausgabe iiber den LMB (Local Mem-
ory Bus) dauert offenbar nicht linger als drei Takte. Das ist nur ein Drittel der Zeit fiir eine
Datenausgabe iiber den AXI-Bus. Abb. 10 zeigt die aufgezeichneten Trace-Signal aus Abb. 9
nochmal als Listing, in dem zu allen Befehlsworten mit »Trace Valid Instr=1« die Assem-
blernotation und die Funktion mit angegeben sind. Die Sample-Zahlung im Listing beginnt mit
null. Bei der Zeitzdhlung ist der Nullpunkt der Triggerzeitpunkt.

3Hinweis zur Problembeseitigung: Nach jedem Programmneustart in SDK oder, wenn statt der erwarteten
Signalverliufe mit Chipscope fiir viele Takte hintereinander Einsen aufgezeichnet werden, ist mit » JTAG Chain

> Close Cable« die Kabelverbindung zu trennen und mit %% neu zu éffnen.
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BusiSignal

&= GFO1

o Trace Instructicn

o= Trace PC

Trace Valid Instr

3 2 1 0 1 2 3 4 &5 6 7 8 9 10 11 12 13 14 15 16 17 18
N I 2 N N I N [N [ NN [N (NN NN NN (NN NN
onooatin 00000111 I 00001000
E0830004 %.| % E0730004 E0930004 . 4 EO730004 4.
622 hEICK B30 (F34F38063CH 640 MB204624) 523 B2C 530 B34
[ S I B L I I I

Abbildung 9: Aufgezeichnete Trace-Signale fiir einen Schleifendurchlauf

Sample | Led-Ausgabe abgeschlossener Befehl

/ Zeit. (GPOL1) PC Instruction disassembl. Funktion

9 /-1 00000110 | 0x628 | ungiiltig

10 /0 00000111 0x62c | 0xF0830000 sbi r4, r3, 0 mem(r3) :=r4

11 /1 00000111 0x630 | 0xE0730004 lbui r3, r19, 4 r3 := mem(FP+4)
12 /2 00000111 0x630 | ungiiltig

13/3 00000111 | 0x630 | ungiiltig

14 /4 00000111 0x634 | 0x30630001 addik r3, r3, 1 13 =13 +1
15/5 | 00000111 | 0x638 | OxFO730004 | sbir3,r19, 4 | mem(FP+4) i— 3
16 / 6 00000111 0x63C | 0xBSOOFFE4 | bri -28 Sprung nach 0x620
17/ 7 00000111 | 0x640 | ungiiltig

18 /8 00000111 | 0x640 | ungiiltig

19 /9 00000111 | 0x620 | 0xB0000004 | imm 4

20 / 10 00000111 0x624 | 0x30600010 addik r3, r0, 16 | r3 := 0x40010

21 /11 00000111 0x628 | 0xF0830000 sbi r4, r3, 0 mem(r3) := r4

22 /12| 00000111 | 0x628 | ungiiltig

23 /13| 00000111 | 0x628 | ungiiltig

24 /14 | 00001000 | 0x62C | 0xEO730004 | lbuir3, 19,4 | 13 :— mem(FP+4)

Abbildung 10: Listing der Trace-Signale zu Abb. 9 mit disassemblierten Befehlen

5 Untersuchung der Timer-Ausgabesignale

Die Festwert-Timer haben eine in der Hardware-Konfiguration mit » Number of Clocks between
Strobes« definierte Zahlperiode, keine Ein- und Ausschaltmoglichkeit und zwei Ausgénge, die
mit » Toggle« und »Interrupt« bezeichnet sind. Es soll untersucht werden, was an diesen Aus-
génge fiir Signale erzeugt werden. Das Testprogramm sei eine Endlosschleife, die nichts tut:

void main(){
while (1){};

¥

Mit der Trigger-Bedingung ».. Interrupt=1«, alle anderen Signale »X« und »Position=10«
ergeben sich die Signalverldufe in Abb. 11. Alle 100 Takte wird das Interruptsignal fiir einen
Takt aktiv. Im Folgetakt invertiert das Toggle-Signal seinen Wert.

BusiSignal

FIT1 Toggle |

5
oy

25
ndlnnnn

45

65 85 105 125 145 165 185

A I R N I U .|

FIT1_Interrupt |

|
|

Abbildung 11: Ausgabesignalverldufe des Festwert-Timers FIT1
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In einem weiterfiilhrenden Experiment wird untersucht, wie lange die Programmreaktion
auf ein Timer-Event dauert. Das Programm priift in einer Endlosschleife das Interrupt-Bit fiir
Timer »FIT1«. Falls es gesetzt ist, wird es geloscht, der Wert der Variabken »dat« auf die Led’s
ausgegeben und weitergezihlt:

#include <xparameters.h>
#include <xio.h>
#define ioadr_led XPAR_IOMODUL_BASEADDR + 0x10
#define ioadr_IRQ_STATUS XPAR_IOMODUL_BASEADDR + 0x30
#define ioadr_TIRQ_ACK XPAR_TIOMODUL_BASEADDR + 0x3C
#define FIT1_EventNr 7
void main(){
u8 dat=0;
while (1){
if (XIo_In32(ioadr_IRQ_STATUS) & 1<<FIT1_EventNr){
XIo_0ut32(ioadr_IRQ_ACK, 1<<FIT1_EventNr);
XIo_Out8(ioadr_led, dat);
}
}
}

Die interessierende Frage ist, wie viele Takte vergehen vom Setzen des Interrupt-Bits bis
zur Anderung der Led-Ausgabe. Abb. 12 zeigt mit der Triggerbedingung » GPO1=0x07« und
»FIT1 Interrupt=1« aufgezeichneten Signalverldufe. Im Bild vergehen 20 Takte, bis sich nach
Aktivierung des Interuptsignals der Led-Wert dndert. Mehrmalige Versuchswiederholung zeigt,
dass die Verzogerung auch bis zu 26 Takte sein kann.

Bus/Signal 1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
e T ] ] ] ] ] ] ] ] ] ] ] ] | | | | | | | |

FIT1 Toggle | | |
FIT1 Interrupt J——|
o GPOL 00000111 ¥ o1000

o . Instruction [{.| YEoooooo4f. (. JBoeooo3dy Ese3accoo . . . 8. 0 0 0 0 W Eossooos L )
o Trace PC VB38Y  B3C_ 4B24nB2B4 B2C_ % R3O0 \B34 B384 BICABA0 | B4 | AIBARICHAS0S 54 fA5a)
. _Walid_Instr ] | | | | I—l—

Abbildung 12: Ausgabverldufe des Timer-Led-Programms

Die Interpretation der Signalverliufe erfordert wieder die disassemblierte Befehlsfolge *:

loop: // Beginn Endlosschleife
624: 80000000 or r0, r0, r0 // nop-Befehl

628: b0000004 imm 4

62c: 30600030 addik r3, r0, 48 // r3 :

ioadr_IRQ_STATUS .._IRQ_STATUS

630: e8630000 1lwi r3, r3, O // r3 := Wert(.._IRQ_STATUS)
634: a4630080 andi r3, r3, 128 // alle Bits aufer FIT1_EventNr ldschen
638: bc03ffec beqi r3, -20 // wenn r3=0, Sprung zu loop

63c: b0000004 imm 4

640: 3060003¢c addik r3, r0, 60 // r3 := Adresse .._IRQ_ACK
644: 30800080 addik r4, r0, 128 // r4 := (1<<FIT1_EventNr)
648: 8830000 swi r4, r3, O // Loschen Ereignisbit

4Schritte zur Disassemblierung: Auf der Xilinx-Console in das Verzeichnis »..\ILA _FitTest\ Debug« wechseln,
ein » Dump« vom Elf-File zu erzeugen und mit einem Editor die Befehlsfolge in der Endlosschleife zu extrahieren.
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64c: b0000004 imm 4

650: 30600010 addik r3, r0, 16 // r3 := Adresse .._led
654: 0930004 1bui r4, ri9, 4 // rd := dat;

658: f0830000 sbi r4, r3, O // Led-Ausgabe := dat
65c: e0730004 1bui r3, ri19, 4 // rd := dat;

660: 30630001 addik r3, r3, 1 // Th++;

664: £0730004 sbi r3, ri19, 4 // dat :=rd

668: b800ffbc bri -68 // Sprung zu loop

Aus den aufgezeichneten Signalverldufen und dem disassemblierten Programmausschnitt ergibt
sich das Trace-Listing in Abb. 13:

Zeit- | Inter- | GPO1 abgeschlossener Befehl
punkt | rupt | (Led) | PC Instruction disassembl. Funktion
0 1 Ob111 | 0x638 | 0xBCO3FFEC | beqir3, -20 wenn r3=0, Sprung zu loop
1 0 Ob111 | 0x63C | ungiiltig
2 0 Ob111 | 0x63C | ungiiltig
3 0 0b111 | 0x624 | 0x80000000 | or r0, r0, r0 nop-Befehl
4 0 0bl111 | 0x628 0xB0O000004 imm 4
) 0 Ob111 | 0x62C | 0x30600030 | r3, r0, 48 r3 :— ioadr TRQ STATUS
6 0 Ob11l | 0x62C | ungiiltig
7 0 Ob111 | 0x630 | 0xE8630000 | lwir3, r3,0 r3 := Wert(.. IRQ_STATUS)
8 0 Ob111 | 0x630 | ungiiltig
9 0 Ob111 | 0x630 | ungiiltig
10 0 Ob111 | 0x634 | 0xA4630080 | andi r3, r3, 128 | Bits aufser FIT1_ EventNr 16schen
11 0 0bl111 | 0x638 | 0xBCO3FFEC | beqir3, -20 wenn r3=0, Sprung zu loop
12 0 0bl111 | 0x63C 0xB0000004 imm 4
13 0 0bl111 | 0x640 0x3060003C addik r3, r0, 60
14 0 Ob111 | 0x644 | 0xA4630080 | andi r3, r3, 128 | Bits aufler FIT1 EventNr 16schen
15 0 Ob111 | 0x648 | 0xF8830000 | swir4, r3, 0 Loschen Ereignisbit
16 0 Ob111 | 0x64C | 0xBO0O00004 | imm 4
17 0 Ob111 | 0x650 | 0x30600010 | addik r3, r0, 16 | r3 := Adresse .. led
18 0 Ob111 | 0x654 | 0xE0930004 | lbui r4, r19,4 r4 :— dat
19 0 Ob11l | 0x654 | ungiiltig
20 0 Obl11l | 0x654 | ungiiltig
21 0 0b1000 | 0x658 | 0xF0830000 | sbir4, 13, 0 Led-Ausgabe := dat

Abbildung 13: Auflistung der Trace-Signale zu Abb. 12

Der Befehl zum Lesen des Interrupt-Statusregisters steht auf Adresse 0x630. In der Beispiel-
aufzeichnung wird dieser Befehl 4 Takte vor Aktivierung und das néchste mal 8 Takte nach der
Aktivierung des Interrupt-Signals abgeschlossen. Nach dem erste Lesen ist das auszuwertende
Ereignisbit offenbar noch nicht gesetzt, so dass der bedingte Riicksprung auf Adresse 0x638 aus-
gefithrt und das Statusregister noch einmal gelesen wird. Nach dem Lesen des Statusregisters
und dem ausgefiihrten Sprung folgen jeweils zwei » Leertakte«, d.h. es wird in den zwei Folge-
takte kein weiterer Befehl abgeschlossen. Nach dem zweiten Lesen des Interrupt-Statusregisters
in Schritt sieben folgen wieder die beiden »Leertakte« und dann werden liickenlos acht Be-
fehle fertig gestellt, d.h. weder nach dem »genommenen« Sprung noch nach dem Schreibbe-
fehl zum Loschen des Ereignisbits folgen Leertakte. Der Befehl auf Adresse 0x650 schreibt
den neuene Wert auf die Led’s und benétigt danach wieder zwei Leertakte. Mit integrierten
Logikanalysatoren lisst sich die Abarbeitung von Programmen sehr detailliert untersuchen und
testen. Der Arbeitsaufwand hierfiir ist jedoch erheblich.
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6 Logikanalysatoreinbau mit dem » ChipScope Inserter«

In der » Debug Configuration« sind nur ausgewéhlte interne und Anschlusssignale fiir den An-
schluss an integrierten Logikanalysatoren zugénglich. Nicht anschliefbar sind insbesonder Sig-
nale von Bussen® Die LMB-Signale sind z.B. unzuginglich.

Einen alternativen Weg mit mehr Gestaltungsspielraum bietet » ChipScope Inserters«. Der
»ChipScope Inserters« verlangt eine Netzliste in Form einer ngc-Datei als Eingabe und erzeugt
eine gednderte ngc-Datei als Ausgabe, die zusdtzlich zur Schaltung den integrierten Logik-
analysator enthéalt. Das Rechnersystem wird ohne Logikanalysatoren entworfen. Dann wird mit
»Generate Netlist« die Netzliste erzeugt, mit dem »»ChipScope Inserter« ein (oder mehrer)
Logikanalysator(en) eingefiigt und die Schaltungsgnerierung mit » Generate Bitstream« fortge-
setzt. Fiir das praktische Vorgehen ist zu empfehlen:

e die Schaltung zuerst ohne die Logikanalysatoren zu entwickeln, zu iibersetzen und mit
Testprogrammen auszuprobieren,

e dann mit
Project > Clean all generated Files

alle automatisch erzeugten und auch alle bei einem vorherigen Einbau eines Logikanalysators
mit dem »ChipScope Inserters« erzeugten Datein zu 16schen und

e die Schaltungsgenerierung mit » Generate Netlist« ohne alte Datein in den Entwurfsverze-
ichnissen zu starten.

Nach der Netzlistenerzeugung ist als Eingabe fiir den »ChipScope Inserter« eine Kopie der
generierten Netzliste mit einem anderen Namen zu erzeugen. Dafiir ist aus EDK Xilinx-Konsole
zu Offnen

Project > Launch Xilinx Shell
in das Unterverzeichnis »implementation« zu wechseln
cd implementation

und das Kopierprogramm mit den Bezeichnern der Eingabe- und der Ausgabe-ngc-Datei zu
starten:

ngcbuild system.ngc systeml.ngc.

Der » Core Inserter« wird iiber das Windows Startmenii im selben Verzeichnis wie der ChipScope-
Analyzer gestartet (Abb. 14).

Xiinx Design Tools
ISE Design Suite 14.6
Accessories
ChipScope Pro
ChipScope 32-bit
ChipScope 64-bit
f% Analyzer

&, Core Inserter
Documentation

Abbildung 14: Start des » ChipScope Core Inserters«

5 Ausgenommen sind der AXI- und der PLB-Bus, fiir die es spezielle Busanalysatoren gibt.
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Im Startfenster des » Core Inserters« ist als »Input Design Netlist« die umbenannte Netzliste
und als »Output Design Netlist« der Netzlistenbezeichner, mit dem der Generierungsprozess
in EDK fortgesetzt wird, sowie der richtige Schaltkreistyp einzustellen (Abb. 15). Im néchsten
Fester des »Core Inserters« ist » USER1« zu belassen und ab dem iibernéchsten sich 6ffnenden
Fester » Trigger Parameter« (Abb. 17) beginnt die Konfiguration des Logikanalysators.

&, ChipScope Pro Core Inserter =10 x|

DEVICE Select Device Options

rDesign Files

Input Design Netlist: |H:\SDﬂpruzessUr\.LMEI_I_-M.implementatinmsystem1.ngc|‘ Browse |
Output Design Netlist: |H:\Soﬁprozessu:ur\.LMEl_I_i\\.impIementatinmsystem.ngc | Browse

Output Directory: |H:18Dﬂpruzessnr\.LMEI_IO‘.impIementatinn | Browse

rDevice Settings
Device Family: ‘Spartanﬁ | - ‘

Abbildung 15: Festlegung der Ein- und Ausgabenetzliste fiir den » Core Inserter«

Der einzubauende Logikanalysator soll die LMB- und Trace-Signale, aus denen die zeitliche
Befehlsabarbeitung rekonstruiert werden kann, sowie die Led-Ausgabe mit dem normalen Sys-
temtakt aufzeichnen. Abb. 16 zeigt eine Skizze der Signalverbindungen. Der Prozessor hat ge-
trennte Schnittstellen fiir Befehle und Daten. Die Befehlsschnittstelle sendet die Befehlsadressen
iiber den »ILMB« und den »ibram cntlr« an den Block-RAM-Port A und bekommt innerhalb
eines Taktes die Befehlsdaten. In den Funktionsblécken »ILMB« und »ibram cntrl« steckt
wenig Funktionalitit. Die Adressen und Daten werden praktisch nur durchgereicht. Die Funktio-
nen und Aufgaben der iibrigen Steuersignale sollen spéter in eigenen Experimenten untersucht
werden.

cpu ILMB P T T T | bram
39 ¢ ibram_cntlr |
@ INSTR_ADDR M_ABUS LMB_ABus . = Addr_A
e LAS -H--a> --+> EN.A
58 INSTR LMB_ReadDBus SI_DBus : : Din_A
‘ga IFETCH ] - ----------- - - - - - -— - 0x0..0 =»{ Dout_A
e IREADY ——— ===~ - -~~~ oo .~ | WEN A
“ DLMB sy |
= DATA_ADDR M_ABUS LMB_ABus T : Addr_B
Q
< D_AS -4--]-> -5> EN.B
£ DATA_READ 33 LMB_ReadDBus SI.DBus 4=+ — Din B
g DATA_WRITE T M_DBus LMB_WriteDBus : =>» Dout_B
é BYTE_ENABLE M_BE T - WEN_B
g pwarr —— """ Ny
A DREADY io
2 LMB_ABus(13, 25:29)
o o Trace PC f——=—> - - - »| LMB_AddrStrobe
= ace_Valid_Instr — ST DBus
5 Trace_OF_PipeRun [—— > — - - »| LMB_ReadStrobe
@ | Trace EX PipeRun f——> LMB_WriteDBus
(] . -
2 %aceieg-\ggge — - - - » LMB_WriteStrobe
= ace_heg._. r —F—> <--- SI_.Read
Trace MEM _PipeRun -

Abbildung 16: LMB- und Trace-Signale des konfigurieten Rechnersystems

Die Datenschnittstelle verhélt sich dhnlich. Sie kommuniziert {iber den »dlmb« und den
»dbram _cntlr« mit Port B des Block-RAMs und kann im Gegensatz zum Befehlsbus auch Da-
ten schreiben. Zusétzlich hingt am Datenbus die IO-Einheit, die sich mit dem »bram cntlr d«
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die vom Prozessor kommenden Daten teilt. Die Adresse und die Ausgabedaten werden vom
Prozessor an beide angeschlossenen Slave-Einheiten praktisch nur durchgereicht. Die Lesedaten
vom RAM und vom I0-Modul kommen auf getrennten 32-Bit-Signalvektoren am »DLMB« an
und werden zu einem 32-Bit-Datenvektor fiir die Weitergabenzum Prozessor weitergeleitet. Der
» DLMB« enthélt offenbar einen 64-32Bit-Multiplexer fiir die vom Prozessor zu lesenden Daten.
Fiir einen Test mit Logikanalysator reicht es, wenn interessierenden Adressen und Daten nur
an einer Stelle beobachtet werden.

Am Trace-Port sind auch Adressen und Daten beobachtbar, aber nicht die der Befehle,
deren Befehlsworte gerade geholt werden, sondern die, die gerade fertig werden. Zusammen
mit einigen weiteren Signalen lassen sich der interne Verarbeitungsfluss im Prozessor und die
aktuellen Registerwerte im Prozessor rekonstruieren.

Nach bisherigen Versuchen darf der einzubauenden Logikanalysator nicht mehr als vier
Block-RAMs verwenden®. Bei einer Aufzeichnungstiefe von 1024 kann ein aus vier Blockspei-
chern aufgebauter Logikanalysator bis zu 71 Dateneingéinge haben. Die nachfolgende Tabelle
zeigt flir das folgende Experiment getroffene Signalauswahl und die geplante Signal-Kanal-
Zuordnung;:

‘ Signal ‘ LA-Kanal ‘ Bedeutung ‘
Led 7 OBUF bis LED 0 OBUF CHO bis CH7 LED-Ausgabe
cpu/INSTR__ADDR<20> bis ..<<31> | CHS8 bis CH19 | gesendete Befehlsadresse

cpu/T_AS CH20 Befehsadresse giiltig

cpu/INSTR<0> bis ..<<31> CH21 bis CH52 gelesenes Befehlswort
cpu/IFETCH CH53
cpu/IREADY CH54

cpu/TracePC<20> ..<31> CH55 bis CH66 Trace-Befehlsadresse

cpu/Trace Valid Instr CH67 Trace-Befehlsadresse giiltig

cpu/Trace OF _PipeRun CH68
cpu/Trace EX PipeRun CH69
cpu/TraceReg Write CH70

Tabelle 1: Vom Logikanalysator aufzuzeichnende Signale

Die Led-Ausgabe ist bitgespiegelt zugeordnet und die Adressen und Daten sind bitgespiegelt
definiert (der hochste Index entspricht dem niederwertigsten Bit). Das ist in der Analyzer-
Anzeige wieder zu korrigieren. Da der Befehlsspeicher nur einen 8k-Byte Adressraum hat, wer-
den nur die niederwertigen 13 bit der Befehlsadressen aufgezeichnet, einmal der Adresse, die an
den Befehlsspeicher gesendet wird und einmal die, die der Trace-Port ausgibt. Von den zusétz-
lich aufzuzeichnenden Steuersignalen werden in den Experimenten nur die Giiltigkeitssignale
ausgewertet. Die restlichen dienen fiir weiterfithrende Untersuchungen.

Insgesamt sind 71 Signale zu beobachten. Diese Zahl ist im Fenster » Trigger Parameters«
Abb. 17 als »Number of Input Trigger Ports« einzutragen. Im néchsten Fenster »Capture
Parameter« sind »Data Depth=1024«, »Data Same As Trigger,/«, »Include TRIGO...,/« etc.
zu belassen. Die insgesamt erforderliche Anzahl von Block-RAMs ist vier.

Im néchsten Eingabefeld » Net Connections« ist mit » Make Connections«, »Clock Signals«
in das Zuordnungsmenii Abb. 18 zu wechseln und links unter » /[system|« als Aufzeichnungstakt
»Clk  BUFGP« auszuwihlen.

Die den ersten Trigger-Eingéingen zuzuordnenden Led-Signale sind auch unter » /[system]«
zu finden (Abb. 19). Alle anderen den Trigg-Ports zuzuordneden Signale stehen im Unterbaum

6 Aus bisher ungeklirten Griinden funktioniert sonst die sich anschliefende Bitstromgenerierung nicht.
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= DEVICE | ILA Select Integrated Logic Analyzer Options |
= ICON :
Uo: ILA f Trigger Parameters r Capture Parameters |/ Net Connections
| rTrigger Input and Match Unit Settings
Number of Input Trigger Ports: I:E Humber of Match Units Used: 1
TRIGO: Trigger Width: |71 Match Type: |Basic wiedges | v |
rCore Wilization # Match Units: IIE Bit Values: 0,1,X,R,F,B,N
Counter Width: |Disabled = Functions; =, <=
2| rTrigger Condition Settings
BRAM Cou... 4 [] Enable Trigger Sequencer Max Number of Sequencer Le\rels:l:l:l
rStorage Qualification Condition Settings
Enable Storage Qualification
Abbildung 17: Einstellung der » Trigger Parameter«
Structure [ Nets Net Selections

¢ I[system]

[ Clock Signals | TriggeriData Signals
o= axi_interconnect_0 [system_axi_interconnect_0_wrapper] ;

Channel
CH:0 IClk_BUFGP

Net Name ‘V|Patlern:| ‘V|
Met Mame Source Instan...| Source Comp... |Base Type :
btn_0_IBUF btn_0_IBUF IBUF IBUF -
Clk_BUFGP Clk_BUFGP BUFGP BUFGP [=]

Abbildung 18: Auswahlfenster des Aufzeichnungstakts

»CPU« (Abb. 20). Mit »Net_ Namex, einer Teilzeichenkette des Namens als »Pattern« und
dann »Filter« lassen sich die zuzuordnenden Signale einfacher finden.

Structure | Nets Net Selections

: Clock Signals | Trigger/Data Signals

: ||| Channel
lcH:0  lLed_7_oBUF
lcH: Led_6_OBUF

[ »

¢ I[system]
o= axi_interconnect_0 [system_axi_interconnect_0_wrapper]

e

i || Pattern: [Lea- = |[ Fiter | |ich2iea_s_ouF

Met Name Source Instan._..| Source Comp.. | Base Type l]\TP{J- |

Led 7 _0OBUF iomodul system_iomodul .. |FDRE -

Led 6 0OBUF iomodul system_iomodul .. |FDRE = ‘ e - H — —
Led_S_OBUF iomodul system_iomodul... [FDRE drE Lonnectons pve Nels Up

Abbildung 19: Auswahlfenster fiir die Ein- und Ausgabenetzliste

Nach der Auswahl der Aufzeichungstakts und der Zuordnung der 71 Datensignale zu den
71 Trigger+Daten-Ports ist das Zuordnungsfenster mit » OK« zu verlassen. Dann sind mit

File > Save As > bus_test.cdc

eine cdc-Datei fiir den konfigurierten Logikanalysator zu speichern und mit »insert« ein Berech-
nungsprozess zU starten, der den Logikanalysator in die Netzliste »system.ngc« eingefiigt. Das
dauert einige Minuten. Dann ist in EDK mit »Generate Bitstream« und »Export Design« die
Bitdatei zu erzeugen und die Hardwarebeschreibungsdateien in ein SDK-Projekt zu exportieren.
In SDK ist wieder ein Board-Suppoert-Package anzulegen, ein » Application Project« anzulegen
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Structure | Hets i| Met Selections
o= cpu [system_cpu_wrapper] ‘| [ Clock Signals | Trigger/Data Signals|_

Net Hame |v‘ Pattern: — l‘:(:Il-r;:as?lmel R

Met Name Source Instan... | Source Comp... |Base Type | :{||CH:55 _ |/cpurTrace_PC<20>
Trace_PC<20=  |cpu system_cpu_wr... [FDE o|[ICH:56_JicpurTrace PC<21=
Trace_PC<21=  |cpu system_cpu_wr... [FDE o|[ISH:ET _JicpuiTrace PC<22-
Trace_PC<22=  |cpu system_cpu_wr... [FDE o|lCH:58 _ licpurTrace PC<23=

Trace PC<23= |cpu system_cpu_wr... |FDE :[ICH:59  YcpuiTrace PC=24>
Trace_PC<24>  |cpu system_cpu_wr... [FDE :|[|[CH:60  lcpuTrace PC<25>
Trace_PC<25=  |cpu system_cpu_wr... |FDE ||lcH:61_icpuiTrace_PC<26>

Abbildung 20: Auswahlfenster fiir die Ein- und Ausgabenetzliste

#include <xparameters.h>
#include <xio.h>
#define ioadr_led XPAR_IOMODUL_BASEADDR + 0x10
void main(){
u8 dat=0;
while (1){
XIo_Out8(ioadr_led, dat);
dat++;
}
+

Befehlsfolge der innersten Schleife:

loop:

620: b0000004 imm 4

624: 30600010 addik r3, r0, 16 //r3:=iocadr_led
628: e0930004 1bui r4, rl19, 4 //rd:= *adr_dat
62c: f0830000 sbi r4, r3, 0 //*iocadr_led:=r4
630: e0730004 1bui r3, rl9, 4 //r3:=xadr_dat
634: 30630001 addik r3, r3, 1 //r3++

638: £0730004 sbi r3, r19, 4 //*adr_dat:=r3
63c: b800ffe4 bri -28 // springe nach loop

Abbildung 21: Testprogramm und disassemblierte Befehlsfolge der innersten Schleife

und in diesem eine Programmdatei anzulegen, das Programm einzugeben und zu iibersetzen,
eine »Run Configuration« zu erzeugen, das Programm zu starten und das ausfiihrbare Pro-
gramm zu disassemblieren.

Abb. 21 zeigt das Testprogramm und die dissasemblierte Befehlsfolge der inneren Schleife.
Die lokale Variable »dat« hat offensichtlich die Adresse

adr_dat := r19 +4

(r19 — Frame-Pointer). Das Ausgaberegister fiir die Leuchtdioden hat die konstante Adresse
»ioadr led = 0x40010«.

Wenn das Programm liduft, ist der »ChipScope Analyzer« zu starten, mit == die Ka-
belverbindung zu 6ffnen, das cdc-File zu importieren, sind die Led-Ausgaben zu einem Bus
zusammenzufassen, die Signalvektoren mit » Reverse Bus Order« zu spiegeln, etc. Der Aufzeich-
nungs-Trigger soll so eingestellt werden, dass die Aufzeichnung 10 Takte vor dem Signalwechsel
der Led-Ausgabe nach 0x07 beginnt. Abb. 22 zeigt die aufgezeichneten Signale.
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Bus/Sianal 1 0 1 2 3 4 5 6 7 8
— | M | | | | | | | |

o /led i EN

o fcpu/THSTR JESOOFFE4: 3021FFAC ¥FaE10000{Boo000045060001 0¥E0S300044F0530000%

o~ /cpu/INSTR ADDR ac K G40 Y B44 % B0 % G244 B2B A BIC A B30 %
Jfepu/I_RS |

o /cpu/Trace PC b BiC B30 W B34 W mIB A RIC A B40 W
fopu/Trace Valid Inatr | | | |—

Abbildung 22: Aufgezeichnete Signale

Die ausgesendeten Befehlsadressen sind bei »I AS=1« giiltig. Die zugehdrigen Befehls-
daten werden einen Takt verzogert aufgezeichnet. Die Trace-Adressen sind gegeniiber den
aufgezeichneten Adressen deutlich verzogert. Abb. 23 zeigt die augezeichnete Signalfolge ohne
Befehlsworte mit kleinerem »Zoom«. Die Zeitfenster, in denen die Adressen ungiiltig sind
(»INSTR__ADDR« bei bei »I _AS=0« und »Trace  PC« bei »Trace Valid Instr=0« sind rot
gekennzeichnet. Es ist zu erkennen, dass vom Aussenden der Adresse an den Befehlsspeicher bis
der Befehlabschluss am Trace-Port angezeigt wird, fiinf bis acht Takte vergehen. Als néachstes
kénnte man anhand der Trace-Signale fiir die Befehle, die die Pipeline anhalten (der Spei-
cherbefehl auf Adresse 0x6C und der Sprungbefehl auf Adresse 0x63C«) untersuchen, welche
Pipeline-Phasen wihrend ihrer Abarbeitung angehalten werden.

BusiSignal |5 . . . . % . o . 5| . . o 1:] o . . 1|5
o /led 06 i 07 A
o /cpu/INSTR ADDR 34 A3 » G40 Fa0 640 Y
epu/1_as I s ——————————— S S B
o /cpu/Trace PC 20 628 O B28 - B30
fepu/Trace Valid Tnser| | [ | [ 1. [ 1. T ""1__

Abbildung 23: Signalaufzeichnung mit kleinerem Zoom und Kennzeichnung ungiiltiger Adressen

7 'Test der seriellen Schnittstelle

Bei einer seriellen Kommunikation mit 9600 Baud dauert die Ubertragung eines Bytes etwa 1 ms.
Mit den 100MHz-Prozessortakt miisste die Datentiefe des Aufzeichnungsspeichers mindesten
10° betragen. Das erfordert eine iibermiRig groft Anzahl an Block-RAMs. Die Alternative ist
die Abtastung mit einen langsameren Takt, z.B. in unserem Projekt mit dem 500 kHz Signal
am Toggle-Ausgang von Festwert-Timer FIT1. Die Toggle- und Interrupt-Signale der Timer
erscheinen nur in der Netzliste, wenn die Signale in der Schaltung genutzt werden’. In Abb.
3 ist, damit er fiir den Anschluss des Logikanalysators verfiighar bleibt, der IO-Modulausgang
»FIT1 Toogle« mit dem Signal »T500kHz x« und dieses mit dem Port » PORT T500kHz«
verbunden.
Der Einbau des neuen Logikanalysators erfolgt wie im vorherigen Projekt:

e Project > Clean all generated Files

o Gerate Netlist

"Die Logik fiir ungenutzte Ausginge wird offenbar schon bei der Netzlistengenerierung wegoptimiert.
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e ngcbuild system.ngc systeml.ngc

Dann wird mit dem »ChipScope Inserter« der neue Logikanalysator konfiguriert. Im ersten
Fenster des »ChipScope Insterters« bleiben die Einstellungen fiir » Input Design Netlist« etc.
wie in Abb. 15. Im néchsten Fenster bleibt » USER1«. Im Menii fiir die Trigger-Parameter soll
» Trigger Width« dieses mal auf 10 gesetzt werden (Abb. 24).

f Trigger Parameters r Capture Parameters |/ Net Connections |
rTrigger Input and Match Unit Settings
Number of Input Trigger Ports: I:IEI Number of Match Units Used: 1

[

TRIGO: Trigger Width: |10 | Match Type: |Basic wiedges |V|

rTrigger Condition Settings
[_] Enable Trigger Sequencer Max Number of Sequencer Levels:l:D

rStorage Qualification Condition Settings

Enable Storage Qualification

Abbildung 24: » Trigger Parameter« des Logikanalysators fiir den UART-Test

Im Menii fiir die Einstellung der » Capture Parameter« soll » Data Depth« auf 2048 vergrofert
werden. Der Preis dafiir sind zwei statt nur ein Block-RAM (BRAM Count 2, Abb. 25).

= DEVICE ILA Select Integrated Logic Analyzer Options
= ICON
Uo: ILA

f Trigger Parameters r Capture Parameters |/ Net Connections |

rCapture Settings
- Sample On Clock Edge
BRAM Count: 2 Data Depth: | 2048 Samples Data Same As Trigger

"Trigger Ports Used As Data

Include TRIGO Port (width=10)

Abbildung 25: »Capture Parameter« des Logikanalysators fiir den UART-Test

An den Takteingang des Logikanalysators ist wie in Abb. 26 das auf einen Schaltungsausgang
gefithrte Toggle-Signal » T200kHz OBUF« vom Festwert-Timer FIT1 anzuschliefsen.

Structure / Nets Net Selections
¢ I[system] il f{llock Signals rTriggerfData Signals
<] ] | ||[channel
---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- CHO HZUUKHZ_DBUF
Net Name ‘V|Paﬂern: *OBUF* ‘V| Filter | -

i’ CPO
Met Mame Source Instan...| Source Comp... |Base Type §5
an_0_0BUF iomodul system_iomodul... [FORE -~ ‘ Make Connections H Move Nets Up |
ReTx_OBUF iomodul system_iomodul .. [FDS (=] -
T200kHz_OBUF  |iomodul system_iomodul.. [FDR - ‘ Remove Connections H Move Nets Down |

Abbildung 26: Auswahl des Aufzeichnungstakts

An die Trigger- und Dateneingénge des Logikanalysators sollen der serielle Ein- und der serielle
Ausgang der UART sowie die Ausgabesignale an die Leds angeschlossen werden (Abb. 26).
Nach der Abschluss der Konfiguration ist der Logikanalysator mit »Insert« einzufiigen, die
Schaltungsgenerierung mit » Generate Bitstream« und » Export Design« abzuschliefsen. In SDK
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Structure / Nets ﬁ Net Selections
¢ [lsystem] fd Clock Signals | Trigger/Data Signals |_
o= axi_interconnect_0 [system_axi_interconnect_0_wrapper] |&| % i"Ch I
— anne
O — || Hlcho  RsTx_oBUF
""""""""""""""""""""""""""""""""""""""""""""""""""""""""" = | [ sRx_IBUF
i || Pattern: [-euF- .~ |[ Fiter | |ichz ned_o_oBur
‘AllcH:3 ed_1_oBUF
Net Name Source Instan...| Source Comp... | Base Type i ||}C ==
A[ICH:4 Led_2_OBUF
btn_0_IBUF btn_0_IBUF IBUF IBUF -~ H|-|EH'5 Led_S_DBUF
Clk_BUFGP Clk_BUFGP BUFGP BUFGP |||'CHE Led_4_DBUF
R=Rx_IBUF R=Rx_IBUF IBUF IBUF |||CHT Led_S_DBUF
Led 7 _0OBUF iomodul systemn_iomodul .. |FDRE |||'CH8 Led_E_DBUF
Led 6 0OBUF iomodul systemn_iomodul .. |FDRE |||'CH9 Led_?_DBUF
Led_5_OBUF iomodul system_iomodul... |FDRE BE ==

Abbildung 27: Auswahl der zu beobachtenden Signale

ist ein neues » Application Project« mit eine C-Datei mit dem Testprogramm in Abb. 28 zu
erzeugen. Das Testprogramm definiert eine Sende- und eine Empfangsfunktion und wartet in
einer Endlosschleife immer auf ein Zeichen, gibt den Zeichenwert auf die Led’s aus und sendet
das Zeichen zuriick.

#include <xio.h>

#include <xparameters.h>

// Registeradressen siehe [pg052-iomodule[1].pdf, S. 13, Tab. 2-5]
#define ioadr_UART_RX XPAR_IOMODULE_O_BASEADDR + O

#define ioadr_UART_TX XPAR_IOMODULE_O_BASEADDR + 0x04

#define ioadr_UART_STATUS XPAR_IOMODULE_O_BASEADDR + 0x08

#define ioadr_led XPAR_IOMODULE_O_BASEADDR + 0x10

// Empfangsfunktion fiir ein einzelnen Zeichen u8 getc(){
// warte bis "Rx Valid Data" (UART_STATUS.O) gesetzt ist
while (!(XIo_In8(ioadr_UART_STATUS) & (1<<0))){};
return XIo_In8(ioadr_UART_RX);

+

// Sendefunktion fiir ein einzelnes Zeichen void sendc(u8 c){ // warte solange "Tx Used" (I
XIo_Out8(ioadr_UART_TX, c);

s
void main(){
u8 c;
while (1)1
c = getc(); // Warte auf Empfangszeichen
XIo_Out8(ioadr_led, c); // Ausgabe auf die Led’s
sendc(c); // Zuriicksenden des Zeichens
s
}

Abbildung 28: Testprogramm fiir den UART-Test

Nach erfolgreicher Programmiibersetzung sind
e der FPGA neu zu programmieren,
e ein » Run Configuration« ist anzulegen,

e das Programm mit » Run« zu starten,
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e HTerm zu starten und
e zum Test ein Zeichen an den Softprozessor zu senden.

Nach dem Programmstart und dem initialen Programmtest mit HTerm erfolgt ein Wechsel
zum »ChipScope Analyzer«. Im »ChipScope Analyzer« muss wie nach jedem Programmstart
die Kabelverbindung mit » JTAG Chain > Close Cable« geschlossen und neu gedffnet sowie die
neue cde-Datei, die zuvor mit dem » ChipScope Inserter« abzuspeichern ist, importiert werden.
Die Triggereinstellung sei wie in Abb. 29 eine null auf dem Empfangssignal »RsRx [BUF«.

; Match Linit Function Value Radix Counter |
=l MoTRIGD = WA OM0| Bin
o
fLed_0_0OBUF X
/RsTx_0OBUF X
RsRx_IBUF 0
;‘ Add || Active| Trigger Condition Mame Trigger Condition Equation
= - TriggerConditiond Mo
(] ki WA . - YT,
g|- Wwindow || windows: 1| Depth: |2048 |+ Position: [ 10
5 Storage Qualification: All Data

Abbildung 29: Triggereinstellungen

Nach dem Aufzeichnungsstart und dem Versenden des Zeichens »a« wird die Signalfolge in
Abb. 30 aufgezeichnet. Die Angaben auf der Zeitachse sind bei einem Aufzeichungstakt von
500 kHz mit 2 ps zu multiplizieren. Die Ubertragung eines Bytes dauert, wie vorhergesagt, etwa
1ms.

Bus/Sianal |12 70 150 230 310 390 470 550 630 710 790 870 950 1030
g 7 N T A RN AP RN PRI R AP A R S

o= fled on K T

/RaTx_OBUF | | | [

/RsBx IBUF | | |

Abbildung 30: Aufgezeichnete Signalverldufe fiir den UART-Test



